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Chapter

INTRODUCTION

This Quick Start gives a brief overview of using the different components in MATFOR
version 4.0. Language considerations, the structure of programs, and the use of
advanced tools are all covered.

l. PRODUCT DESCRIPTION

MATFOR is a set of numerical and graphical libraries developed to enhance computation
and visualization in different programming environments: C++, Fortran, Visual Basic and
Visual C#. Especially designed for scientists and engineers, MATFOR aims to
accurately perform computation, dynamically visualize data, and efficiently decrease
process time. Its features include:

mfArray integrates the entire MATFOR toolkit into high-level programming
environments such as C++, Fortran, Visual Basic and Visual C#, simplifying the
syntax and facilitating object-oriented programming.

Numerical Library contains useful linear algebraic functions subject to assist users
with computational problem solving.

Visualization Library collects well-designed graphical procedures and controls to
support a variety of 2D and 3D visual functions.

Data Viewer, organized in spreadsheet format, is one convenient platform for data
management, filter, and analysis.

Graphics Viewer, besides its highly customized user interface, overthrows the
convention of post-processing as it instantly visualizes scientific and engineering
data.

Graphics Export converts dynamic presentation into standalone movie or image
files to enhance accessibility of simulation results.
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MATFOR Control facilitates application-building by integrating its graphic component,
MatforWidget, into VB and C# environments.

Il COMPILER REQUIREMENTS

MATFOR supports these compiler choices:

*  Visual C# 2005

[ll.  INSTALLATION

This section provides step-by-step instructions for installing MATFOR. If you encounter
any problems during the installation, please contact support@ancad.com.

* Pre-Installation

Exit any of MATFOR programs executing;

Remove all previous versions of MATFOR components if this is an upgrade;
Ensure the compiler requirements are satisfied;

Obtain administrator rights under Windows 98/2000/NT/XP.

w0 DnPE

* Begin Installation
1. Insert the MATFOR CD into the CD-ROM drive.

The standard MATFOR Installation Procedure shall start automatically. If the
Procedure fails to start, you may manually start it by double-clicking on the
MATFOR.exe file under the <CDROM>\Content\ path.

2. Follow the self-explanatory instructions in the Procedure to set up all MATFOR
components.

3. Specify a destination folder to create MATFOR through the Procedure.

By default, the Package creates a program group in your C drive under the path
C:\Program Files\AnNCAD\MATFORA4\.

e Set Environment Path
The Procedure automatically sets the $PATH environment variable.

To manually set the environment variables:
1. Goto Control Panel\System.
2. Inthe System Dialog Box, select the Advance label and click on the Environment


mailto:support@ancad.com
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Variables tab.

3. Inthe System Variables Box, add <MATFOR4>\bin and <MATFOR4>\tools to
the [path] variable.

NOTE
<MATFOR4> shall specify the directory under which MATFOR is installed.
i.e. C:\Program Files\AnCAD\MATFOR4

IV. REGISTRATION

At the end of the installation, you are required to enter the License Password for
registration, which can only be obtained by submitting the Host ID of your local machine
to us: (For trial users, please obtain the License Password by sending email to
sales@ancad.com.)

1. Go to http://www.ancad.com/activation.php to activate MATFOR with the Serial
Number and Host ID information.

2. MATFOR license key should be sent to you through the email provided within 24
hours.

V. FLOATING LICENSE & CLASSROOM LICENSE

To enable a group of developers to share a pool of licenses more efficiently, MATFOR
offers floating licenses and classroom licenses for cross-system/cross-platform
environments. The floating license is designed to be used in any shared network
environment; the classroom license is designed for the purpose of teaching in an
academic environment. Any project developed under MATFOR classroom license may
not be redistributed to a third party with profit interest or being a commercial institution.

These license models consist of one or more license servers; the license server runs the
license management process and monitors number of concurrent users using MATFOR
licenses in the network. The installation steps are:

¢ Installation of License Servers

1. Runlicense_server.exe (download from http://www.ancad.com/activation.php) on
machines designated as license servers.

2. Retrieve required information from the machine.
Under command prompt,


http://www.ancad.com/activation.php
http://www.ancad.com/activation.php
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i.  Change directory to C:\Program Files\AnCAD\License Server.
ii. Execute Imtools to get Ethernet Address and Host Name.
Collect the following product information:

i.  Compiler version

ii. Operating system

iii. Number of license of each version

Obtain license file(s) for license server(s).

i. Go to http://www.ancad.com/activation.php to activate MATFOR with the
Serial Number and Host ID information.

ii. The license file(s) should be sent to you through the email provided within 24
hours.

5. Place the license file xxx.lic into <AnCAD=>\License Server directory.

6. Start the license server.

Under command prompt, type:
Imgrd —c xxx.lic or
Imgrd —c . for multiple license files.

e Configuration in Client Computers

1.

Install MATFOR on machines designated as clients.

2. Go to Start P Program Files » MATFOR4 P Utilities > Register MATFOR.
3.
4. Fill in the Host Name or IP Address of the license server in the blank area. (IP

Under Registration Window, choose Network License.

Address can be obtained from the license server by typing Imhostid -internet —n
under command prompt.)

For other questions regarding MATFOR floating license or classroom license installation
and registration, please contact support@ancad.com.
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Chapter

ENVIRONMENT SETTING

As a library, manual configuration is required to use MATFOR under different compiler
environments. This chapter is composed to guide users to configure project setting under
Microsoft Visual C#.

l. MICROSOFT VISUAL C#

Open Microsoft Visual Studio 2005.

Go to File » New P> Project.

Select Visual C# from the Project types menu.
Select Console Application from Templates.

a s w b ke

Enter a name for the new file, specify its location, and click OK.
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New Froject

Froject types: Templates: |E|
Tisnal C++ Yizual Studio installed templates
(=) Dther Languages
izual Blagi (] Windows Application A Class Liban
E Windows Control Liboame I, Congole 4pplication
e 8 Dewvice Application
Smart Dewice ﬁ PP
Starter Kits
Vimal 1§ My Templates
Other Project Types i
Intsl(R) Fortran Projects ] Search Cnline Templates. .
A project for creating a command-line applisation |
-
Hame: ( |dem|31 ) |
Location: |m w | Brows...
Solotion Nane: | demol | Cieate directory for solution
[ 444 to Somrce Contral
OK | [ Camcel |

6. Select Add Reference from the Project menu.

7. Select MatforNet from the Component Name menu under the .NET tab and click

OK.
Add Reference @
NET | COM || Projects | Browse || Eecent
Compomeint Name Wersdon Euntive Path i
[TIEHo=t 2000 w2 050727 CAWINN T\bicrosoft ...
Liarm W rapper 2000 w2 050727 CAWINN T'Wicrosoft H..
| oo 102476 114322  CAProgram Filed\dnCA4
g 1.024%0. . AProgram Files\AnC A o
piTrrermerie L hobile Q02420 w2 050727 CAProgram Fileshicios...
Microsoft Analvssfends... 902420 w2 050727 e’Program Files\Micros.
Micromft Budd Convers... 2000 w2 050727 CAWINN T\bicrosoft ...
Micromft Build Engine 2000 w2 050727 CAWINHN T\Microsaft N
Microsoft Budld Framew .. 2000 w2 050727 CAWINN T\bicrosoft M.
Microsoft Budld . Tasks 2000 w2 050727 CAWINN T\bicrosoft ...
Microsnft Budld Ttilities 2000 w2 050727 CAWINHN T\Microsaft M.
Microsoft Budd Figvalld... 2000 w2 050727 CAWINN T\bicrosoft M.
Microsoft CompactFrame... 8.0.00 w2 050727 CAWINN T'Wicrosoft H..
Microsaft Divectd 1029020 «114322  CAWINET\Microsaft N
Microsoft Directi Avdin... 1029020 114322  CAWINNTMicrosoft M.
Microsoft Directi Diagn... 1029020 114322  CAWINNTMicrosoft M. b
0K || Caneel
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Chapter

FUNDAMENTALS

This chapter is an introductory summary on how to integrate MATFOR into C#
programming. Beginning with mfArray, the core of MATFOR, the chapter subsequently

introduces the numerical library and the visualization library.

l. MFARRAY

mfArray is a dynamic array endorsing the data types and dimensions listed in Table 3.1.

Data Type Statement
string a = “string”
boolean a=true

int a=1

float a=1.0f
double a = 3.1418f

Table 3.1 | mfArray Data Types
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mfArray Declaration
1. Include MATFOR library to appropriately contain mfArray.
2. Declare mfArray using the format mfArray <variable>

Example Code (ch3-1)

using System;
using MatforNet;

namespace demo

{
class demol
{
[STAThread]
static void Main(string[] args)
{
/[ Declare mfArray variables x and y
mfArray X, Y ;
/' x is a scalar
X=6.0;
/l'y is a 1-by-five vector containing real values
y = mf.V(1.0, 2.0, 3.0, 4.0, 5.0) ;
/I Call mfDisplay function to display x and y data
mf.Display(x, "x",y, "y");
}
}
}

Result
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Il NUMERICAL PROCEDURES

MATFOR embraces a comprehensive set of numerical procedures furnished with
easy-to-call syntax to complement mfArray. Various categories of numerical procedures
are contained in the set and are hereto listed in Table 3.2.

For a complete list of the numerical routines and descriptions on their usage and
functionality, please refer to the Reference Guide.

Procedure Group Example Description

Data Manipulations mf.Sort Sort data in ascending order
Arithmetic Operators mf.RDiv Right-divide the matrix
Trigonometry mf.Cos Request cosine function
Exponential mf.Log Request natural logarithm
Complex mf.Conj Generate conjugate of

complex

Rounding and Remainder  mf.Cell Round towards positive

infinity
Matrices mf.Magic  Construct magic square
Matrix Manipulations mf.Find Find indices of nonzero
elements
Matrix Analysis mf.Norm Generate matrix/vector norm
Linear Equations mf.Chol Requ_est _Cholesky
factorization
Eigenvalues and Singular Perform Schur
mf.Schur o
Values decomposition
Factorization Utilities mf.Balance Perform diagonal scaling

Table 3.2 | Numerical Procedure Brief

Numerical Procedure Call
Use “MatforNet” to appropriately contain the numerical routine(s).
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Example Code (ch3-2)

Result



14 MATFOR QUICK START
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1
1
2
2
2
3
3
3

. VISUALIZATION PROCEDURES

In addition to the numerical procedures, MATFOR endorses a collection of visualization
routines to enhance data comprehension. Table 3.3 summarizes the procedures and
introduces an example routine with description for each procedure group.

Procedure Group Example Description

Set the frame size of Graphics
Viewer window

Window Management mf.WindowSize
Visualization Controls mf.Subplot Create subplot in active figure
Graph Options mf.Surf Construct 3D surface plot

Advanced Graph
Options

Construct 3D Delaunay

mf.GetDelaunay3 . )
triangulation
Object Manipulations  mf.ObjOrigin Set the origin of the drawn object

Specify the colormap type of the

Appearance Settings  mf.Colormap drawn object

Annotations mf.Title Annotate the graph with title
3D Objects mf.Sphere Draw a sphere

Table 3.3 | Visualization Procedure Brief
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For a complete list of the visualization routines and descriptions on their usage and
functionality, please refer to the Reference Guide.

Visualization Procedure Call
Use “MatforNet” to appropriately contain the visualization routine(s).

Example Code (ch3-3)
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Result

Value
1.96

0.98

0.00

-0.98

-1.96
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A FIRST PROGRAM

This chapter presents one simple visualization program for users to manipulate and

Chapter

extend as animation and recording procedures are introduced.

l. HELLO SURFACE

The section shall take you step by step to create a surface plot.

Create a New Project

1. Select Console Application from Templates.
2. Name the project “demol,” specify its location, and click OK.

New Project
Project types: Templates: |E|

Visnal C++ Yiznal Studio installed templates

= Other Languages I

tamal Bagi (=] Windows Application ] Class Liboag,
A Windows Control Librecy
evice LﬂDevice Application
Starter Kits
Visnal J# My Templates
COrther Project Types .
Intel(R) Fortran Projects |2 Search Online Templates...
|A project for creating & command-line application |
b
Name: demol ) |
Location: IC:) w | Erowss...
Solution Name: | demol | Create directory for solution
[ 244 o Souree Contral
[ ok ][ Cancel




18 MATFOR QuICK START

Adding the Source Code (ch4-1)
In “Program.cs,” type in:

Line-by-Line Walkthrough

using MatforNet;

This includes the library file MatforNet which contains the MATFOR numerical and
visualization procedures.

mfArray X, Y, z;
This declares mfArray variables x, y, and z.

mf.Meshgrid(mf.Out(out x, out y), mf.Linspace(-3, 3, 30), mf.Linspace(-3, 3, 30));
This creates x and y grid matrices from the domains specified by Linspace-generated
vectors.

- mf.Out(out X, out y) specifies x and y as mfArray outputs.
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- mf.Linspace(-3, 3, 30) constructs a vector with 30 linearly spaced points between -3
and 3.

z = mf.Sin(x) * mf.Cos(y);
This defines z mathematically.

mf.Surf(x, y, z)
This creates a three-dimensional surface plot of the x-, y-, and z-coordinates.

mf.ViewPause();

This halts program execution for graphical display. mf.ViewPause() should be added
after each set of graphical creation routines.

Compile and Run

I MATFOR 4.1 - [Figure 1]
o File ¥iew geting Took Toolper Windows Help

g@bs HBo s+ ha"Mee @A BE |0

[I.  TO ANIMATE HELLO SURFACE

In this section, the Hello Surface demo code is modified to generate animation.

Animation

Animations effects are produced by continuously updating data displayed in the Graphics
Viewer.

To Animate Data
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Use MatforNet to appropriately contain the numerical and visualization routine(s).
Construct and initialize the mfArrays for plotting.
Create a static plot of the graph to be animated.

Set up an iteration loop for the range of data to be observed through animation.

ok w0 bdPRE

Within the loop, use procedure mf.GSet(handle, ‘axis-data’, data) to update the
targeted data of the current draw.

6. Update the drawn figure accordingly by using procedure mf.DrawNow.

7. Use procedure call mf.ViewPause after the end of animation to observe the static
graph.

Example Code (ch4-2)
Modify the previously created “Program.cs” file as follows and rename it “Programz2.cs”:

using System;
using MatforNet;

namespace demol

{
class Program2
{
[STAThread]
static void Main(string[] args)
{

/I Declare mfArray variables

mfArray X, Y, z, h;

/I Declare an integer variable

inti;

/[ Construct grid matrices for 3D plotting

mf.Meshgrid(mf.Out(out x, out y),
mf.Linspace(-3, 3, 30),
mf.Linspace(-3, 3, 30));

h =0; // Define h
for (i=1;1<=30; i++) Il Create loop
{

/[ Mathematically define z

z =mf.Sin(x +i/8.0) * mf.Cos(y);

if (i==1)

{
/I Plot a surf using mfArrays x, y, and z
h = mf.Surf(x, y, z);
mf.DrawNow();

}

else

{

/I Update the figure as the z-coordinate varies
mf.GSet(h, "zdata", z);
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mf.DrawNow();

}
} // End loop
/I Pause to display the graph
mf.ViewPause();

Line-by-Line Walkthrough
using MatforNet;

This includes the library file MatforNet which contains the MATFOR numerical and
visualization procedures.

mfArray X, Y, z, h;
This declares mfArray variables x, y, z, and h.

inti;
This declares an integer variable i.

mf.Meshgrid( mfOut(out x, out y), mf.Linspace(-3, 3, 30), mf.Linspace(-3, 3, 30) )

This generates x and y grid matrices from the domains specified by the
mf.Linspace-generated vectors. This procedure aims to solve functions for two
variables by plotting 3D graphs.

for (i =1; i <=30; i++)
This creates a loop running from i=1 to i=30.

z = mf.Sin(x+i/8.0) * mf.Cos(y);
This defines z mathematically. Note that the equation involves the loop index i.

if i==1){
At the beginning of the loop,
h = mf.Surf(x, y, 2);
This creates a three-dimensional surface plot of the x-, y-, and z-coordinates.
mf.DrawNow ();
This displays the initial figure.
else
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At all other times during loop execution,
mf.GSet(h, "zdata", z);
This sets the z-coordinate for update.
mf.DrawNow/();
This displays and updates the figure during loop execution.

mf.ViewPause();
This halts program execution for graphical display.

Compile and Run
7 BNy
)
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[ll.  TO RECORD HELLO SURFACE

This section revises the previous sample code to perform animation recording.

Recording

MATFOR allows recording of animated simulation to facilitate date
presentation with comprehensiveness and readability.

To Record Animation

1. Use MatforNet to appropriately contain the numerical and visualization
routine(s).
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2. Use procedures mf.RecordStart(“animation.avi”) and
mf.RecordEnd() before and after the animation codes to record the
animation.

Example Code (ch4-3)

Add the recording routines to the previously created “Program2.cs” file and rename it
“Program3.cs” (Note: only the modified and added lines are shown in colors):
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Chapter

THE ADVANCED FEATURE

This chapter focuses on the graphic components of MATFOR Control and how they are

used to facilitate application-building and code integration.

As a graphic component of MATFOR Control, MATFOR Widget component can be
embedded into numerous Ul design environments to enable application execution.

MATFOR WIDGET

Integration with Microsoft Visual C# (ch5-1)

1.
2.

Select Window Application from Templates.
Name the project “demo3,” specify its location, and click OK.

New Project

Project types: Templates: |§|
Wisnal C++ Yizual Studio installed templates
= Other Languages
iznal Basic ¢ | Windows Application @Class Library
2 i W FEWE OOl Library %Con&ol& Application
Stmart Tevice LgﬁDewce Application
Starter Kits
Visnal J# My Templates
Cither Project Twpes .
Intsl(R) Fortran Projects [ Seawch Online Templates...
|}L project for creating an application with a Windows vser interface |
s T |
Location: | Ch w | Browss...
Solution Name: | demo? | Create directory for solution
[ 444 1o Source Control
[ ox ][ Comeel
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3. Select Add Reference from the Project menu.

Select MatforNet from the Component Name menu under the .NET tab and click
OK.

5. Select MatforControl from the Component Name menu under the .NET tab and
click OK.

?X

Add Reference

HET

| COM || Projects | Browss | Fecent

Component Feame Wersdon Euntime Path A
envd el anon w1 03705 CAProgram FilesvCZomm.
ExreptiontdesmgeBox Q02420 w2 050727 e\Program Files\WMicmos.
extensbility T033000  »103705 CAProgram Files\Conum. .. —
[EEx=ecEemote 2000 w2 050727 CAWINN TWicromft N ..
[EHost 2000 w2 050727 CAWINN T'icromft ...
IIEHost 2non0 w2 050727 CAWINN T'icromit ...

T 2000 w2 050727 '-.WII-II-IT'-.Iv{mmmft I-I ..

IE 102476 w11 43008 : B3

< 1024%a... 114302 C \.Prc:gra.m Files\bnC L .
Micrus:ft 0L Mobile 02420 w2 0.50727  CAProgram Filestbicros. .
Microsoft Anabvdsterviz... 202420 wa 0.507327  o\Program Files\Microz...
Microsoft Budd Conversi... 2.00.0 w2 050727 CAWINN T\Microsoft V...
Microsoft Build Engine 2000 w20.50727  CAWINNT\Microsoft V...
Microsoft Build Framew ... 2.00.0 w2 050727 CAWINNT\Microsoft N,
Microsoft Build. Tasks 2000 w2 050727 CANWINNT\Microzoft ..
Microsoft Budld Utilities 2000 w2 050727 CAWINNT\Microsoft ... b

[ oK || Concel |

6. On the Tools menu, click Choose Toolbox Items.

Under the .NET Framework Components tab, check the box next to MatforwWidget
and click OK. MatforWidget shall appear in Toolbox. (By default, the new item will be
appended to the bottom of the list under current tab.)

Chooze Toolbox [tems

MNET Framework Components | COM Components

Mame Mamespace Agsemnbly Name Directory #
[#] Masked TextBox Sorstenn, Wind ows Forms Sstern. Windows Forms .. Global As
=z dBowchorray Microsoft VisvalBasic Compatibi...  Microsoft VisnalBasic C... Global Az
AR atforWid get MatforComtool MatforContmol (1. 0247 CAPoogra
S Sarztern. Web UL WebControls Saretern. Web (2.0.0.0) lobal fe—
[] Menultembiray Microgoft VisvalBazic Compatibi..  Microsoft VisvalBasic C...  Global Az
Menuitoap Sztern. Windows Forms Svzter, Windows Forms ... (Global ¢
[ Message Svstem Mesmping Svstem Mesmgmg (200, Global As
MezageQueve Svetem Mesmping SvrtemMesmging (200, C\Progom hd
< |
Filter |
MatforWid get
Langoage:  Invariant Languags (nvariant Country)
‘iﬁ' Version: 10247621754 (Fetad)

0K || Cancel

=
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10.

11.

ES}

Toolbox

All Windows Forms
Common Controls
Containers

Menuz & Toolbars
Data

Components
Frinting

Dialogs

General

R Pointer

ﬁﬁ Matfor Wid et

N3 T T

Go to Forml.cs [Design], add Button and MatforWidget to Form1.
Click on buttonl. Enter Close for under Properties Window.
Click the Events button in Properties Window and set Click to button1_Click.

buttonl Click S

MoumClick
[ Appearance
Paint
= Behavior

ChangelICues
Controltdded
ControlR.emaved
HelpReguested
CQuervhceessbilitvHelp =
StyleChanged
SweternColorsChanged
= Data
{DataBindings)
B Drag Drop

DiragDirop

DiragEnter

Dragleave

DiragOwer

GiveFeed back

CueryiContinueDrag
= Focus

Enter

Leave

Validated

Validating
ChangelOICues

Oeeurs when focus rectangles and kewboard cue undexlines are being
shown or hidden.

| £

Add the following codes in Forml.cs:
private void buttonl_Click(object sender, EventArgs e)
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this.Close();
}

12. SetlLoad to Forml Load.

13. Add the following codes in Forml.cs::
private void Form1_Load(object sender, EventArgs e)

{
mfArray X, Y, z;
mf.CreateSurfData(mf.Out(out x, out y, out z), 1, 30, 35);
mf.Surf(x, y, 2);
mf.DrawNow();
}

14. Add the following header to “Forml.cs”:
using MatforNet;

Compile and run

Form1
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